Copyright

The data in this document may not be altered or amended without special notification from ETAS GmbH. ETAS GmbH undertakes no further obligation in relation to this document. The software described in it can only be used if the customer is in possession of a general license agreement or single license. Using and copying is only allowed in concurrence with the specifications stipulated in the contract.

Under no circumstances may any part of this document be copied, reproduced, transmitted, stored in a retrieval system or translated into another language without the express written permission of ETAS GmbH.

© Copyright 2014 ETAS GmbH, Stuttgart

The names and designations used in this document are trademarks or brands belonging to the respective owners.

1 Introduction

This manual addresses tool administrators or system administrators who configure members of the ASCET product family for other users.

Familiarity with the ASCET product family and with the Microsoft Windows® Vista or Windows® 7 operating system is required.

1.1 Safety Advice

Please adhere to the Product Liability Disclaimer (ETAS Safety Advice) and to the following safety instructions to avoid injury to yourself and others as well as damage to the device.

1.1.1 Correct Use

ETAS GmbH cannot be made liable for damage which is caused by incorrect use and not adhering to the safety instructions.

1.1.2 Labeling of Safety Instructions

The safety instructions contained in this manual are shown with the standard danger symbol shown below:

WARNING
Indicates a possible medium-risk danger which could lead to serious or even fatal injuries if not avoided.

CAUTION
Indicates a low-risk danger which could result in minor or less serious injury or damage if not avoided.

NOTICE
Indicates behavior which could result in damage to property.

1.1.3 Demands on the Technical State of the Product

The following special requirements are made to ensure safe operation:

- Take all information on environmental conditions into consideration before setup and operation (see the documentation of your computer, hardware, etc.).
Further safety advice is given in the "Safety Advice" sections in the different manuals, as well as in the ASCET V6.3 safety manual (available at ETAS upon request).

1.2 Further Documentation

1.2.1 ASCET Documentation

ASCET provides an online help and several PDF manuals. The following volumes are stored in the ETAS\ETASManuals folder.

- ASCET V6.3 Installation.pdf
- ASCET V6.3 Getting Started.pdf
- ASCET V6.3 AUTOSAR Users Guide.pdf
- ASCET V6.3 GUI Reference.pdf
- further manuals for the various ASCET add-on products

Using the index, full text search, and hypertext links, you can find references fast and conveniently.

The ASCET online help can be accessed via the <F1> key.

1.2.2 ASCET-DIFF Documentation

ASCET provides an online help and a PDF installation guide, ASCET-DIFF V6.3 Installation.pdf, which is stored on the installation disk.

The ASCET-DIFF online help can be accessed via the Help → Help Contents menu option.

1.3 Conventions

**Documentation Conventions**

All actions to be performed by the user are presented in a task-oriented format as illustrated in the following example. A task in this manual is a sequence of actions that have to be performed in order to achieve a certain goal. The title of a task description usually introduces the result of the actions, e.g. "To create a new component", or "To rename an element". Task descriptions often contain illustrations of the particular ASCET window or dialog window the task relates to.

**To achieve a goal:**

Any preliminary information...

- **Step 1**
  
  Explanations are given underneath an action.

- **Step 2**
  
  Any explanation for Step 2...

- **Step 3**
  
  Any explanation for Step 3...

Any concluding remarks...
Typographic Conventions

The following typographic conventions are used in this manual:

Select **File → Open**. Menu commands are shown in **blue boldface**.

Click **OK**. Buttons and options are shown in **blue boldface**.

Press <ENTER>. Keyboard commands are shown in angled brackets and **CAPITALS**.

The "Open File" dialog window opens. Names of program windows, dialog boxes, fields, etc. are shown in quotation marks.

Select the file **setup.exe**. Text in drop-down lists on the screen, program code, as well as path- and file names are shown in the **Courier** font.

A **distribution** is always a one-dimensional table of sample points. General emphasis and new terms are set in **italics**.

The OSEK group (see **http://www.osekvdx.org/**) has developed certain standards. Links to internet documents are set in **blue, underlined** font.

Important notes for the users are presented as follows:

**Tip**

*Important note for users.*
2 ASCET – Option Customization

A company may want to restrict the possibilities to set ASCET options or project properties for several reasons, e.g., the following:

- Specific values for ASCET options/project properties are defined by, e.g., coding guidelines.
- If options were modified, the model or the generated code might be wrong or might not fit customers’ needs.
- It is difficult to trace a problem back to changed options.

Section 2.1 describes the XML definition of an ASCET option/project property. The External Options mechanism (section 2.2) available in ASCET can be used to add user-defined options to ASCET, and the option customization feature (section 2.3 and 2.4) available in ASCET can be used to adjust default values of options, to make options read-only, and/or to hide options.

2.1 Option Definition

The definition of an option has the following basic format (code sections in *italics* must be replaced with suitable values for each option):

```xml
<OptionDeclaration
  xmlCategory="path"
  optionCategory="value"
  optionClass="type"
  attributeName="option name"
  optionFile="filename.xml"
  sensitive="true/false"
  visible="true/false">
  <Group>path</Group>
  <Label>text</Label>
  <Description>text</Description>
  <Tooltip>text</Tooltip>
  <InitialValue>value</InitialValue>
  <DefaultValue>value</DefaultValue>
  <Value value>value</Value>1
  <FileOption definition>definition</FileOption>2
  <EnumerationOption definition>definition</EnumerationOption>2
  <ButtonOption definition>definition</ButtonOption>2
  <NumericOption definition>definition</NumericOption>2
</OptionDeclaration>
```

1. Not present in the automatically generated options file (cf. page 10 and section 2.4.1); must be added manually. Effective only in *.aoc.xml files.
2. only available for a special optionClass
2.2 External Options in ASCET

User-defined options can be added to ASCET via a special an XML file that you modify to suit your own requirements. The file is stored in the ASCET installation directory; for ASCET to recognize it, it must have the following extension:

`*.aod.xml`

For more details, see the ASCET online help, “Component Manager” section.

2.3 Customization Features

Of the attributes and items that form the option declaration of an existing option (see section 2.1), only a few can be customized.

<table>
<thead>
<tr>
<th>Attribute/Item</th>
<th>Customization allowed</th>
<th>not supported</th>
<th>forbidden</th>
</tr>
</thead>
<tbody>
<tr>
<td>optionCategory</td>
<td>+</td>
<td></td>
<td></td>
</tr>
<tr>
<td>attributeName</td>
<td>+</td>
<td></td>
<td></td>
</tr>
<tr>
<td>optionClass</td>
<td>+</td>
<td></td>
<td></td>
</tr>
<tr>
<td>xmlCategory</td>
<td>+</td>
<td></td>
<td></td>
</tr>
<tr>
<td>sensitive</td>
<td>+</td>
<td></td>
<td></td>
</tr>
<tr>
<td>visible</td>
<td>+</td>
<td></td>
<td></td>
</tr>
<tr>
<td>optionFile</td>
<td>+</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;Group&gt;</td>
<td>+</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;Label&gt;</td>
<td>+</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;Description&gt;</td>
<td>+</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;Tooltip&gt;</td>
<td>+</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;InitialValue&gt;</td>
<td>+</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;DefaultValue&gt;</td>
<td>+</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;Value&gt;</td>
<td>+</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;FileOption&gt;</td>
<td>+</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;EnumerationOption&gt;</td>
<td>+</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;ButtonOption&gt;</td>
<td>+</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;NumericOption&gt;</td>
<td>+</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Tab. 2-1** Customizable option attributes – overview

ASCET remains master of the options, i.e. you **cannot** use customization to do the following:

- delete existing options
- create new options
- change option types
- rename internal option identifiers
- use an invalid or wrong value as default value
- change option dependencies (you cannot change, e.g., that an option becomes editable only if another option has a certain value)
2.4 Customization Procedure

**General Procedure:**
1. Installing and starting ASCET
2. Creating an option customization file named *.aoc.xml
3. Copying the *.aoc.xml file(s) into the ASCET installation directory
   
   This can be done, e.g., via customized installations.
4. (Re-)Starting ASCET
   
   Upon starting, ASCET first reads the built-in option definitions, and then the customized option definitions in the *.aoc.xml files.

**Creating a template for the *.aoc.xml file:**

- In the component manager, select **Tools → Options** to open the ASCET options dialog window.
- In the options dialog window, make sure that the focus is in the tree view.
- Press <ALT> + <D>. The Windows file selection window opens. The default file name OptionDeclarations.aoc.xml is suggested. The file extension .xml is predefined and cannot be changed. The extension *.aoc.xml is mandatory for option customization files.
- Enter path and file name for the option customization file and click on **Save**. The file is saved. An extract of the file is given in section 2.4.1 on page 11.

**Tip**

*The generated file contains option types that cannot be customized (see also section 2.4.2). You must remove these option types before you can use the file for option customization.*

**Creating the *.aoc.xml option customization file:**

- Open the automatically created *.aoc.xml file in a suitable editor.
- Open a new, empty *.aoc.xml option configuration file.
- Copy the following lines into the new file.

```xml
<?xml version="1.0" encoding="US-ASCII"?>
<OptionDeclarations

xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"

xsi:noNamespaceSchemaLocation="externalOptions.xsd">

</OptionDeclarations>
```
ETASASCET – Option Customization

- Copy the `<OptionDeclaration>` sections of the options you want to customize into the new file between the `<OptionDeclarations ...>` and `</OptionDeclarations>` tags.

As an alternative, you can remove at least the options that cannot be customized (see section 2.4.2 on page 14) from the automatically created `*.aoc.xml` file.

For clarity, you can remove any options you do not want to customize.

- For the options you want to customize, proceed as follows.
  - Go to the respective `<OptionDeclaration>` section.
  - Set the `visible` attribute to `true` to show the option.
  - Set the `visible` attribute to `false` to hide the option.
  - Set the `sensitive` attribute to `true` to make the option editable.
  - Set the `sensitive` attribute to `false` to make the option read-only.
  - Enter the desired `<Value>`.
  - Enter the desired `<DefaultValue>`.

**Tip**

*Changing an option’s default value does not change the current value of that option.*

- Save the option customization file.

For the option customization to become effective, the option customization file must be copied to the ASCET installation directory of each ASCET user.

### 2.4.1 Generated Option Customization File – Extract

```xml
<?xml version="1.0" encoding="US-ASCII"?>

<OptionDeclarations
  xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
  xsi:noNamespaceSchemaLocation="externalOptions.xsd">
  <OptionDeclaration
    optionCategory="FILE"
    attributeName="UserActionsBufferSize"
    optionClass="EtasNumericOption"
    xmlCategory="ToolSettings"
    visible="true"
    sensitive="true"
    optionFile="d:\ETASData\ASCET6.3\User\ml_user\userSettings.xml">
    <Group></Group>
  </OptionDeclaration>
</OptionDeclarations>
```
<Label>User Actions Buffer Size</Label>
<Description>Define the size of last
\&lt;i&gt;n\&lt;/i&gt; user actions
that are stored and transmitted on a walkback</Description>
<Tooltip>Number of user actions to be Stored</Tooltip>
<InitialValue>100</InitialValue>
<DefaultValue>100</DefaultValue>
<NumericOption>
  <MinValue>0</MinValue>
  <MaxValue>1000</MaxValue>
</NumericOption>
</OptionDeclaration>
...

<OptionDeclaration
  optionCategory="FILE"
  attributeName="WatermarkShow"
  optionClass="EtasContainerOption"
  xmlCategory="EditorSettings\BlockDiagram"
  visible="true"
  sensitive="true"
  optionFile="d:\ETASData\ASCET6.3\User\ml_user\userSettings.xml">
  <Group>Appearance\Editors\Block Diagram</Group>
  <Label>Show Watermark</Label>
  <Description>Show Watermarks (e.g. the currently
  selected View) in BDE</Description>
  <Tooltip>Show Watermarks in BDE</Tooltip>
  <InitialValue>true</InitialValue>
  <DefaultValue>true</DefaultValue>
</OptionDeclaration>

<OptionDeclaration
  optionCategory="FILE"
  attributeName="WatermarkSize"
  optionClass="EtasNumericOption"
  xmlCategory="EditorSettings\BlockDiagram"
  visible="true"
  sensitive="true"
  optionFile="d:\ETASData\ASCET6.3\User\ml_user\userSettings.xml">
  <Group>Appearance\Editors\Block Diagram</Group>
  <Label>Watermark Size (px)</Label>
  <Description>Fontsize of the Watermark in BDE</Description>
  <Tooltip>Size of the Watermark</Tooltip>
  <InitialValue>20</InitialValue>
  <DefaultValue>20</DefaultValue>
</NumericOption>
ETASASCET – Option Customization

...<MinValue>1</MinValue>
<MaxValue>200</MaxValue>
</NumericOption>
</OptionDeclaration>
...

<OptionDeclaration
  optionCategory="FILE"
  attributeName="PageNumberShow"
  optionClass="EtasBooleanOption"
  xmlCategory="EditorSettings\BlockDiagram"
  visible="true"
  sensitive="true"
  optionFile="d:\ETASData\ASCET6.3\User\ml_user\userSettings.xml">
  <Group>Appearance\Editors\Block Diagram</Group>
  <Label>Show Page Number</Label>
  <Description>Show the page number in the BDE</Description>
  <Tooltip>Show Page Number in BDE</Tooltip>
  <InitialValue>false</InitialValue>
  <DefaultValue>false</DefaultValue>
</OptionDeclaration>
...

<OptionDeclaration
  optionCategory="FILE"
  attributeName="DisplayConnectionPortSelectionBox"
  optionClass="EtasBooleanOption"
  xmlCategory="EditorSettings\BlockDiagram"
  visible="true"
  sensitive="true"
  optionFile="d:\ETASData\ASCET6.3\User\ml_user\userSettings.xml">
  <Group>Appearance\Editors\Block Diagram</Group>
  <Label>Display Connection Port Selection Box</Label>
  <Description>Only in Connection Mode: With the mouse over the diagram elements there is an extra selection box showed for the selection of the connection ports.</Description>
  <Tooltip>Display the Connection Port Selection Box</Tooltip>
  <InitialValue>true</InitialValue>
  <DefaultValue>true</DefaultValue>
</OptionDeclaration>
...
2.4.2 Options that Cannot be Customized

Only options with simple values can be customized. Options with other than simple values cannot be customized, they can only be hidden and/or set to read-only.

- button and link options (optionClass="EtasButtonOption"), e.g. the ones shown below

- options used to set several items (optionClass="EtasMultiSelectConfigurationOption"), e.g. the one shown below
ETASASCET – Option Customization

- options used to select several items (optionClass="EtasMulti-SelectEnumerationOption"), e.g. the one shown below

- container options (optionClass="EtasContainerOption"), i.e. options with dependent child options, e.g. the one shown below

  Tip
  When you hide a container option, its child options are hidden, too.

- options with optionClass="EtasEditableEnumerationOption", e.g. the one shown below
• options with optionclass="EtasEditableXMLFileOption" (A) or "EtasPathTokenFileOption" (B), e.g. the ones shown below

2.4.3 Example *.aoc.xml Option Customization File

By default, the options Display Connection Port Selection Box, Show Watermark and Show Page Number in the "Block Diagram" node of the ASCET options dialog window are visible and editable. The option Watermark size (px) is visible, too, and is editable as long as Show Watermark is activated.

Fig. 2-1 Options with system default values

The following *.aoc.xml file is used to customize the four options. Changed settings are marked in **bold blue**, the option names are marked in **bold black**.

```xml
<?xml version="1.0" encoding="US-ASCII"?>
<OptionDeclarations
    xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
    xsi:noNamespaceSchemaLocation="externalOptions.xsd">
  <OptionDeclaration
    optionCategory="FILE"
    attributeName="WatermarkShow"
    optionClass="EtasContainerOption"
    xmlCategory="EditorSettings\BlockDiagram"
    visible="true"
    ...>
```
sensitive="false" optionFile="d:\ETASData\ASCET6.3\User\ml_user\userSettings.xml">
  <Group>Appearance\Editors\Block Diagram</Group>
  <Label>Show Watermark</Label>
  <Description>Show Watermarks (e.g. the currently selected View) in BDE</Description>
  <Tooltip>Show Watermarks in BDE</Tooltip>
  <InitialValue>true</InitialValue>
  <DefaultValue>true</DefaultValue>
</OptionDeclaration>

<OptionDeclaration optionCategory="FILE" attributeName="WatermarkSize" optionClass="EtasNumericOption" xmlCategory="EditorSettings\BlockDiagram" visible="true" sensitive="true" optionFile="d:\ETASData\ASCET6.3\User\ml_user\userSettings.xml">
  <Group>Appearance\Editors\Block Diagram</Group>
  <Label>Watermark Size (px)</Label>
  <Description>Fontsize of the Watermark in BDE</Description>
  <Tooltip>Size of the Watermark</Tooltip>
  <InitialValue>20</InitialValue>
  <DefaultValue>50</DefaultValue>
  <Value>50</Value>
  <NumericOption>
    <MinValue>1</MinValue>
    <MaxValue>200</MaxValue>
  </NumericOption>
</OptionDeclaration>

<OptionDeclaration optionCategory="FILE" attributeName="PageNumberShow" optionClass="EtasBooleanOption" xmlCategory="EditorSettings\BlockDiagram" visible="true" sensitive="false" optionFile="d:\ETASData\ASCET6.3\User\ml_user\userSettings.xml">
  <Group>Appearance\Editors\Block Diagram</Group>
  <Label>Show Page Number</Label>
  <Description>Show the page number in the BDE</Description>
  <Tooltip>Show Page Number in BDE</Tooltip>
  <InitialValue>false</InitialValue>
</OptionDeclaration>
<DefaultValue>true</DefaultValue>
<Value>true</Value>

<OptionDeclaration>
  <OptionCategory>FILE</OptionCategory>
  <AttributeName>DisplayConnectionPortSelectionBox</AttributeName>
  <OptionClass>EtasBooleanOption</OptionClass>
  <XmlCategory>EditorSettings\BlockDiagram</XmlCategory>
  <Visible>true</Visible>
  <Sensitive>true</Sensitive>
  <OptionFile>d:\ETASData\ASCET6.3\User\ml_user\userSettings.xml">
    <Group>Appearance\Editors\Block Diagram</Group>
    <Label>Display Connection Port Selection Box</Label>
    <Description>Only in Connection Mode: With the mouse over the diagram elements there is an extra selection box showed for the selection of the connection ports.</Description>
    <Tooltip>Display the Connection Port Selection Box</Tooltip>
    <InitialValue>true</InitialValue>
    <DefaultValue>true</DefaultValue>
    <Value>false</Value>
  </OptionDeclaration>
</OptionDeclarations>

The file is copied to a user's ASCET installation directory, and ASCET is started. The "Block Diagram" node now looks as follows:

![Options with changed <Value> and <DefaultValue>](image)

**Fig. 2-2** Options with changed `<Value>` and `<DefaultValue>`

*Show Watermark* and *Show Page Number* are now read-only. Since the *.aoc.xml* file contains `<Value>` parameters, the current values of the options are changed (cf. Fig. 2-1).
If you omit the `<Value>` parameters, and change only the `<DefaultValue>` parameters, the “Block Diagram” node looks slightly different than in Fig. 2-2: The option values are still the same as the system default (cf. Fig. 2-1), since the option customization file did not change the current option values.

The new default values can be set via the System Defaults button, but keep in mind that this button restores all default values in the selected node.

When ASCET is closed and restarted, the changed values and default values are still in place.
3 ASCET-DIFF

3.1 Customizing Command-Line Installation

A company may want to customize installation paths and mode for their users. This can be achieved by editing selected parameters in the InstallationDefaultSettings.xml file on the installation disk. See the ASCET-DIFF installation guide for details on command-line installation.

The code extract shows the relevant part of that file; customizable parameters are shown in blue font. Tab. 3-1 lists the variables and their meaning.

```xml
<Package
  ID="ASCET_DIFF ASCET-DIFFInstallPack_6.3.x.y"
  displayName="ASCET-DIFF">
  <CustomParameters>
    <Variable name="PRODINSTDIR"
      defaultValue="[globalvar:ProgramFiles]\ETAS\ASCET-DIFF6.3.x"
      validation="path" />
    <Variable name="PRODDATAINSTDIRALL"
      defaultValue="[globalvar:CommonApplicationData]\ETAS\ASCET-DIFF\6.3.x"
      validation="path" />
    <Variable name="PRODDATAINSTDIRUSERNOROAM"
      defaultValue="[globalvar:LocalApplicationData]\ETAS\ASCET-DIFF\6.3.x"
      validation="path" />
    <Variable name="PRODDATAINSTDIRUSERROAM"
      defaultValue="[globalvar:ApplicationData]\ETAS\ASCET-DIFF\6.3.x"
      validation="path" />
    <Variable name="WORKSPACE_PATH"
      defaultValue="C:\ETAS\ASCET-DIFF\6.3.x"
      validation="path" />
    <Variable name="PRODUCT_TITLE"
      defaultValue="ASCET-DIFF"
      validation="none" />
    <Variable name="PRODUCT_FOLDER_VERSION"
      defaultValue="[packagevar:xyversion]"
      validation="none" />
  </CustomParameters>
</Package>
```

**Tip**

Do not change other variables in the InstallationDefaultSettings.xml file.
A company may want to use a predefined set of comparison configurations, different from the ETAS default configurations, with ASCET-DIFF. Section 3.2.1 describes how comparison configurations are treated in ASCET-DIFF, and section 3.2.2 explains how to change default comparison configurations.

### 3.2 Configuring Default Settings

#### 3.2.1 ASCET-DIFF Preferences

The "Preferences" window of ASCET-DIFF stores various comparison configurations.

![Fig. 3-1 ASCET-DIFF – "Preferences" window](image)

<table>
<thead>
<tr>
<th>Variable</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>PRODINSTDIR</td>
<td>installation directory</td>
</tr>
<tr>
<td>WORKSPACE_PATH</td>
<td>workspace path created during installation</td>
</tr>
<tr>
<td>PRODUCT_TITLE</td>
<td>text in the title bar</td>
</tr>
<tr>
<td>PRODUCT_FOLDER_VERSION</td>
<td>determines the installation mode:</td>
</tr>
<tr>
<td></td>
<td>[packagevar:xyversion] - standard;</td>
</tr>
<tr>
<td></td>
<td>[packagevar:xysversion] - side-by-side</td>
</tr>
</tbody>
</table>

**Tab. 3-1 Customizable installation variables**

**Tip**

Unlike ASCET options, you cannot set the ASCET-DIFF comparison configurations to read-only. Users can change your company defaults.

After the installation of ASCET-DIFF, the ETAS default configurations are available in an ASCII file named DamePreferences.properties and stored in the `plugins\com.etasgroup.ascet.diff.mainui_1.0.0\resource` folder in the ASCET-DIFF installation directory.

If a user starts ASCET-DIFF for the first time, the options in the "Preferences" window are set to the values in the DamePreferences.properties file. In addition, the file is copied to the `workspace\<user name>` folder in the
ASCET-DIFF workspace location. If the user changes settings in the "Preferences" window, these changes are stored in \workspace\<username>\DamePreferences.properties.

The Restore Defaults button available in each node of the "Preferences" window can be used to reset changed values and restore the defaults in a node.

3.2.2 Changing Default Settings

Changing the ETAS default configurations to company configurations consists of the following steps:

- Adapting a copy of the DamePreferences.properties file to your company’s needs (see section 3.2.3 and section )
- Distributing the changed DamePreferences.properties (see section )
### 3.2.3 Adapting the DamePreferences.properties File

Tab. 3-2 lists the entries in DamePreferences.properties file and the location of the respective option in the "Preferences" window. The entries are sorted alphabetically in the table; sorting in the file may differ.

<table>
<thead>
<tr>
<th>*.properties entry</th>
<th>possible values</th>
<th>name / location in &quot;Preferences&quot; window</th>
</tr>
</thead>
<tbody>
<tr>
<td>bdIndex</td>
<td>[0..8]</td>
<td>BD, &quot;Default View&quot; node</td>
</tr>
<tr>
<td>cbrIndex</td>
<td>[0..6]</td>
<td>AUTOSAR Calibration Interface, &quot;Default View&quot; node</td>
</tr>
<tr>
<td>ccodeIndex</td>
<td>[0..9]</td>
<td>C Code, &quot;Default View&quot; node</td>
</tr>
<tr>
<td>compare</td>
<td>flat / quick / detailed</td>
<td>Comparison Variants field, &quot;Comparison and Component Settings&quot; node</td>
</tr>
<tr>
<td>compareComponents</td>
<td>sameName / sameOID / twoSelected</td>
<td>Component selection option field, &quot;Comparison and Component Settings&quot; node</td>
</tr>
<tr>
<td>compareOpenClosedHierarchy</td>
<td>true / false</td>
<td>Compare open and closed hierarchy state, &quot;Comparison and Component Settings&quot; node</td>
</tr>
<tr>
<td>compareProcess</td>
<td>name / index</td>
<td>Process comparison option field, &quot;Comparison and Component Settings&quot; node</td>
</tr>
<tr>
<td>compareSeqCallOrder</td>
<td>true / false</td>
<td>Compare order of sequence calls, &quot;Comparison and Component Settings&quot; node</td>
</tr>
<tr>
<td>containerIndex</td>
<td>[0..3]</td>
<td>Container, &quot;Default View&quot; node</td>
</tr>
<tr>
<td>csrIndex</td>
<td>[0..6]</td>
<td>AUTOSAR Client Server, &quot;Default View&quot; node</td>
</tr>
<tr>
<td>deletedElement</td>
<td>[0..255],[0..255],[0..255]</td>
<td>Right new item color, &quot;Colors&quot; node</td>
</tr>
<tr>
<td><code>*.properties entry</code></td>
<td>possible values</td>
<td>name / location in &quot;Preferences&quot; window</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>diffElement</td>
<td>[0..255],[0..255],[0..255]</td>
<td>Different item color, &quot;Colors&quot; node</td>
</tr>
<tr>
<td>doSort</td>
<td>Obsolete option; has no effect and does not need to be customized.</td>
<td>---</td>
</tr>
<tr>
<td>enumIndex</td>
<td>[0..2]</td>
<td>Enum, &quot;Default View&quot; node</td>
</tr>
<tr>
<td>esdlIndex</td>
<td>[0..8]</td>
<td>ESDL, &quot;Default View&quot; node</td>
</tr>
<tr>
<td>Font</td>
<td>all fonts on your PC</td>
<td>Font, &quot;Font&quot; node</td>
</tr>
<tr>
<td>FontSize</td>
<td>8, 9, 10, 11</td>
<td>Font Size, &quot;Font&quot; node</td>
</tr>
<tr>
<td>ignoreBDComments</td>
<td>true/false</td>
<td>Ignore comments in BD, &quot;Comparison and Component Settings&quot; node</td>
</tr>
<tr>
<td>ignoreElementComments</td>
<td>true/false</td>
<td>Ignore comments in Elements, &quot;Comparison and Component Settings&quot; node</td>
</tr>
<tr>
<td>ignoreElementOID</td>
<td>true/false</td>
<td>Ignore element OID and method OID, &quot;Comparison and Component Settings&quot; node</td>
</tr>
<tr>
<td>ignoreESDLComments</td>
<td>true/false</td>
<td>Ignore comments, spaces and blank lines in ESDL/ CCode,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot;Comparison and Component Settings&quot; node</td>
</tr>
<tr>
<td>ignoreLayout</td>
<td>true/false</td>
<td>Ignore layout, &quot;Comparison and Component Settings&quot; node</td>
</tr>
<tr>
<td>ignoreNotes</td>
<td>true/false</td>
<td>Ignore notes, &quot;Comparison and Component Settings&quot; node</td>
</tr>
<tr>
<td>ignorePosition</td>
<td>true/false</td>
<td>Ignore label position, &quot;Comparison and Component Settings&quot; node</td>
</tr>
<tr>
<td>*.properties entry</td>
<td>possible values</td>
<td>name / location in &quot;Preferences&quot; window</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-----------------------</td>
<td>----------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>ignoreSequenceCalls</td>
<td>true/false</td>
<td>Ignore sequence calls, &quot;Comparison and Component Settings&quot; node</td>
</tr>
<tr>
<td>ignoreSMComments</td>
<td>true/false</td>
<td>Ignore comments in State machine, &quot;Comparison and Component Settings&quot; node</td>
</tr>
<tr>
<td>logFeature</td>
<td>true/false</td>
<td>Log Model Characteristics, &quot;Others&quot; node</td>
</tr>
<tr>
<td>logopath</td>
<td>path/name of graphic with extension <em>.jpg/</em>.png/*.bmp</td>
<td>Logo file path, &quot;Printing&quot; node</td>
</tr>
<tr>
<td>minimumScaleFactor</td>
<td>number</td>
<td>Minimum scale factor for Intelligent Layout, &quot;Printing&quot; node</td>
</tr>
<tr>
<td>modeGroupIndex</td>
<td>[0..2]</td>
<td>Mode group, &quot;Default View&quot; node</td>
</tr>
<tr>
<td>newElement</td>
<td>[0..255],[0..255],[0..255]</td>
<td>Left new item color, &quot;Colors&quot; node</td>
</tr>
<tr>
<td>nvIndexIndex</td>
<td>[0..6]</td>
<td>AUTOSAR NVData Interface, &quot;Default View&quot; node</td>
</tr>
<tr>
<td>preferedDeleteCount</td>
<td>integer number</td>
<td>Preferred delete count for overview tree, &quot;Others&quot; node</td>
</tr>
<tr>
<td>printHeaderPage</td>
<td>true/false</td>
<td>Print Header Page, &quot;Printing&quot; node</td>
</tr>
<tr>
<td>projectIndex</td>
<td>[0..12]</td>
<td>Project, &quot;Default View&quot; node</td>
</tr>
<tr>
<td>promptOnExit</td>
<td>true/false</td>
<td>Display prompt on exit dialog, &quot;Others&quot; node</td>
</tr>
<tr>
<td>propagatedElement</td>
<td>[0..255],[0..255],[0..255]</td>
<td>Propagated item color, &quot;Colors&quot; node</td>
</tr>
<tr>
<td><strong>.properties entry</strong></td>
<td><strong>possible values</strong></td>
<td><strong>name / location in “Preferences” window</strong></td>
</tr>
<tr>
<td>----------------------------------------</td>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>recentComparisonEntries</td>
<td>integer number</td>
<td><strong>Recent Comparison Count</strong>, “Others” node</td>
</tr>
<tr>
<td>recordIndex</td>
<td>[0..6]</td>
<td><strong>Record</strong>, “Default View” node</td>
</tr>
<tr>
<td>sameElement</td>
<td>[0..255],[0..255],[0..255]</td>
<td><strong>Identical item color</strong>, “Colors” node</td>
</tr>
<tr>
<td>sendEmail</td>
<td></td>
<td><strong>Obsolete option; has no effect and does not need to be customized.</strong></td>
</tr>
<tr>
<td>sidiff</td>
<td>true / false</td>
<td><strong>Compare Block Diagram/State Machine with SiDiff</strong>, “Comparison and Component Settings” node</td>
</tr>
<tr>
<td>smIndex</td>
<td>[0..8]</td>
<td><strong>Statemachine</strong>, “Default View” node</td>
</tr>
<tr>
<td>snrIndex</td>
<td>[0..6]</td>
<td><strong>AUTOSAR Sender Receiver</strong>, “Default View” node</td>
</tr>
<tr>
<td>swcIndex</td>
<td>[0..11]</td>
<td><strong>AUTOSAR Software Component</strong>, “Default View” node</td>
</tr>
<tr>
<td>tolerance</td>
<td>integer number</td>
<td><strong>Pixel Tolerance</strong>, “Others” node</td>
</tr>
<tr>
<td>triggerLevel</td>
<td>[0..100]</td>
<td><strong>Percentage of transitions to be matched to pick junctions for comparison (%)</strong>, “Others” node</td>
</tr>
<tr>
<td>uncomparedElement</td>
<td>[0..255],[0..255],[0..255]</td>
<td><strong>Not compared item color</strong>, “Colors” node</td>
</tr>
</tbody>
</table>

**Tab. 3-2** Entries and their possible values in DamePreferences.properties and their location in the “Preferences” window of ASCET-DIFF
Open the file in a text editor and edit the file entries according to your needs. Possible values for each option are given in Tab. 3-2. If desired, you can enter comment lines, i.e. lines of the form # <comment text> or remove unchanged lines.

**Example – DamePreferences.properties File**

The original version of DamePreferences.properties is an unsorted list of option=value pairs.

The following example is a changed version of DamePreferences.properties. In addition, the entries have been sorted according to the nodes in the “Preferences” window they refer to. Changed settings are marked in **blue bold** font.

```
#Fri May 17 15:08:35 CEST 2013
#
#Comparison and Component Settings
compare=flat
compareComponents=twoSelected
compareOpenClosedHierarchy=true
compareProcess=index
compareSeqCallOrder=false
ignoreBDComments=true
ignoreElementComments=true
ignoreElementOID=true
ignoreESDLComments=true
ignoreLayout=false
ignoreNotes=false
ignorePosition=true
ignoreSequenceCalls=false
ignoreSMComments=true
sidiff=true
#
#Default View
bdIndex=0
cbrIndex=0
ccodeIndex=0
containerIndex=0
csrIndex=0
esdlIndex=0
enumIndex=0
modeGroupIndex=0
nvdIndex=0
```
Distributing the Changed DamePreferences.properties File

To distribute the changed DamePreferences.properties file to the users' ASCET-DIFF installations, the following steps are required:

1. Identify the ASCET-DIFF installation path.
   You can read the path from a Registry entry.
- On a 64bit operating system, the entry is located at
  HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\ETAS\ASCET-DIFF\6.3.
- On a 32bit operating system, the entry is located at
  HKEY_LOCAL_MACHINE\SOFTWARE\ETAS\ASCET-DIFF\6.3.

2. Add \plugins\com.etasgroup.ascet.diff.mainui_1.0.0\resource to the ASCET-DIFF installation path.
   The resulting path looks similar to this path:
   C:\ETAS\ASCET-DIFF6.3\plugins\com.etasgroup.ascet.diff.mainui_1.0.0\resource

3. Copy the changed DamePreferences.properties file to the resulting path.
   Of course, these steps can be executed by a script.
   As soon as the changed DamePreferences.properties file is copied to the proper location, it's content is available via the Restore Defaults button in the ASCET-DIFF "Preferences" window.

Tip

The changed DamePreferences.properties file does not overwrite existing user-defined preference changes.
ASCET-SCM – File Extension

ASCET-SCM administrates ASCET model information in CM repositories based on ASCET export files, in a binary format (*.exp) and/or an XML-based format (*.amd). See the ASCET online help for more information on the export formats.

By default, ASCET-SCM contains two drivers: SVN and MSSCCI. The exchanged XML-based artifacts differ between the ASCET standard export and each ASCET-SCM driver as follows:

**ASCET standard export:** You can export ASCET components in AMD format (several *.amd files for each exported component) or in AXL format (the *.amd files of each component are combined into one ZIP file named *.axl).

Depending on the ASCET export settings, the *.amd files may contain component paths, ASCET experiments etc. or not (non-fixed export settings).

**ASCET-SCM SVN driver:** The SVN driver uses ZIP files with extension *.zip for exchange with the repository. These ZIP files contain all *.amd files of on component, an XML file with some SCM data for quick and easy access, and optionally the binary export file of the component.

No further ASCET export settings are considered (fixed export settings).

**ASCET MSSCCI driver (or MSSCCI based specific drivers):** The MSSCCI driver uses ZIP files with extension *.axl for exchange with the repository. The content of this *.axl file is the same as the ZIP file of the SVN driver.

This means that two different AXL file formats exist. The main differences are:

- one AXL format includes an XML file with SCM data
- one AXL format has fixed export settings, the other has non-fixed export settings (and may thus include component paths, ASCET experiments, etc.)

Both *.axl file formats can be imported with standard ASCET as well as ASCET-SCM (MSSCCI based drivers). However, a warning is issued when The ASCET-SCM imports (load/check-out) an ASCET standard *.axl file:

"[ASCET V5.x format ...]".

This file without the SCM data was not created under ASCET-SCM control and its potentially different export settings may lead to unpredictable inconsistencies that cannot be managed by the SCM driver.

To make the two formats easier to distinguish, the MSSCCI driver configuration file, e.g. MSSCCIlnDriver.gui.xml, contains an option to set the file extension to be used in ASCET-SCM, i.e., the <StorageFileExtension> option. Possible values are AXL, SXL, and AXL/SXL.

The <StorageFileExtension> option is located in the <Basics> area of the driver configuration file.

**Example:**

```xml
<?xml version="1.0" encoding="utf-8"?>
  <Basics>
    <StorageFileExtension>SXL</StorageFileExtension>
  </Basics>
</ScmServerSettings>
```
<AlwaysUpdateSandbox>true</AlwaysUpdateSandbox>
</Basics>
...

ETASASCET-SCM – File Extension
5  ETAS Contact Addresses

ETAS HQ

ETAS GmbH

Borsigstraße 14
70469 Stuttgart
Germany

Phone: +49 711 3423-0
Fax: +49 711 3423-2106
WWW: www.etas.com

ETAS Subsidiaries and Technical Support

For details of your local sales office as well as your local technical support team and product hotlines, take a look at the ETAS website:

ETAS subsidiaries  WWW: www.etas.com/en/contact.php
ETAS technical support  WWW: www.etas.com/en/hotlines.php
Index

Symbols

*.aoc.xml file
 create 10
 create template 10
 example 16
 template (extract) 11

*.axl
 ASCET-SCM 30

*.sxl
 ASCET-SCM 30

A

ASCET
 option customization 8–19
 see also Option Customization

ASCET options
 definition 8
 external 9
 not customizable 14
 see also Option Customization

ASCET-DIFF
 command-line installation 20
 configure default settings 21–29
 customize installation 20
 preferences 21
 see also default settings (ASCET-DIFF)

ASCET-SCM
 file extension 30

C

customization file
 ASCET-DIFF 23
 create (ASCET) 10
 example (ASCET) 16

D

DamePreferences.properties file
 21
 change 23
 distribute 28
 example (changed) 27
 default settings (ASCET-DIFF) 21–29
 change 22
 DamePreferences.properties
 21
 restore 22

E

ETAS Contact Addresses 32
 external options (ASCET) 9

I

InstallationDefaultSet-
tings.xml file
 ASCET-DIFF 20
O
Option Customization 8–19
  create customization file 10
  create template file 10
  customization file (example) 16
  features 9
  procedure 10
  template file extract 11

P
Product liability disclaimer 5

S
Safety advice 5
  technical state 5

T
  template *.aoc.xml file
    create 10
    extract 11

X
XML file
  *.aoc.xml 10, 16
  *.aod.xml 9